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2020. 11. 20 B4¥ BTN Qt 5.12.9 LTS (Qt B KIS FiA . £4 K 2020. 11. 22 H Qt
B TIEAETE T Qb 12 fRAD . R Qt iUARFRIBZ 474, B2 DiRe , B2 RS, B
JEIE SR AR Z DL Qt5. 12,9 AT Qt4. 8. 4(Qt4 WA, B HRE)MEEZEHMA, Qt5.6.2 IEA
JRF AT . SO R E I 5 SO R Qt i RS (F: WA
R RS, G ERE Qt BIHANRE Qt IS R4 AT LUsAT Qt 25, AT LS %LIE
RUREFY I.MX6U #8248 Qt4. 8.4 V1. x.pdf Al [IEAJEF T 1. MX6U #44 Qt5. 12.9 V1. x. pdf).
WA, WRIEAREFIRIETRIE, BB R A4 S5 1EH 001252699831 18 IEH 1R
ARG T A FH A8
4+  Windows 7 64bits, & T Windows 8-10. ANEAXH Windows 32 Ak %, Windo
ws 32 FISCHFFRINAER/DARR, RGPEREA R
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F—F BET NI
L1 ZRH) RE Qt T XA

VE: A5 P e SRR SOR O 2 e i d kI e 1.1 /N5, 2020.11.20 HJEHT &S5 Q1 38X
i T HLBE B Qt B & TN Qt5.12.9 itAS. 2020.11.20 H Al %3 5T fsl-imx-x11-glibc-x8
6_64-meta-toolchain-qt5-cortexa7hf-neon-toolchain-4.1.15-2.1.0.sh 75 ZL 5 H | £ B 235 . ELHEM
k% sudo rm -rf /opt/fsl-imx-x11/4.1.15-2.1.0 F4% DL N S H7 2e3 .,

O RACEL A-FERETER->5. R T HE->1, 38 X i #s->fsl-imx-x11-glibc-x86_64-meta-
toolchain-qt5-cortexa7hf-neon-toolchain-4.1.15-2.1.0.sh #% J1 3] Ubuntu N1
WrF EA S CAHAS Xk T HA5 ILF] 7 Ubuntu JEEIL.

alientek@ubuntu:~S 1s

fsl-imx-x11-glibc-x86_64-meta-toolchain-qt5-cortexa7hf-neon-toolchain-4.1.15-2.1.0.sh

O s o
alientek@ubuntu:~S

E 1.1 1 # 0 sdk TE S| ubuntu REE
AT T T 8B BUEAS IBUR, B HOBRR 5 AT LU B AS T ¢ R 23, BB T) -
chmod u+x fsl-imx-x11-glibc-x86 64-meta-toolchain-qt5-cortexa7hf-neon-toolchain-4.1.15-2.1.0.sh
ELIRPAT A 22285 X 1 TR, RSN PR Im AN, FRE A R B R R AT . AR
LI H SR ONBAIAS i 58 BRI 2232 1 H 3K, TP PO A S R P A5 1A 58 S RS A A 22
Ha 380, FrEladsl i d 2 BRA 2256 3 opt/fsl-imx-x11/4.1.15-2.1.0 IX MR H % .

allentekmubuntu ~§ ./fsl-imx-x11-glibc-x86_64-meta- tnolcha1n th cortexa7hf-neon-toolchain-4.1.15-2.1.08.sh
Freescale 1 e Distro SDK installer version

Enter target directory for SDK (default Jop .1.0):

You are about to install the SDK to "/opt/fs . .0". Proceed[Y/n]?

[sudo] password for alientek:

Extracting SDK

Setting it up.

SDK has been <ucce<<fu11y set up and is ready to be used.

Each time you to use the SDK in a new shell session, you need to source the environment setup script e.g.
S o /0pt/f<1 imx- x11/4 1.15-2.1.0/environment-setup- cortexa?hf neon-poky- linux-gnueabi

T B 11 2 2% sdk TEEBAHE R
BRI 4 B, R T 4T E ORI, R PR AR BAT IL T . (B R
R 2 T T B 5 55 507 6 B B8 T (i

source /opt/fsl-imx-x11/4.1.15-2.1.0/environment-setup-cortexa7hf-neon-poky-linux-gnueabi

alientek@ubuntu:~$ source fopt/fsl-imx-x11/4.1.15-2.1.0/environment-setup-cortexa7hf-neon-poky-linux-gnueabi
alientek@ubuntu:~5

E 11 3 FEgEfETE
R R B 5 0] LME ] env FR B HE AT E, NE IS #EE, o7 LIE H{ERE
TR R G gec CANE I gPFER FTHMNSE, WnhliF 524 -mfpu=neon -mfloat-abi=h
ard. f# PRV A2 X dw%, ] LME ] CPU HaF FPU. K ERONIRIEAR B0 A .
env

LESSOPEN=| Jusr/bin/lesspipe %s
[ARCH=arm
RANLIB=arm- p)Ly linux-gnueabi-ranlib

s -daenon
CROSS._t COMPILE=arm- p)ky lll\ur\ LELY Y

ky-1inux-gnueabi-gcc | I ETRe -nfpu=neon -nfloat-abi=hard -mcpu=cortex-a7| --sysroot=/opt/fsl-imx-x11/4.1.15-2.1.8/sysroots/cortexa7hf-neon-poky-linux-gnueabi
DIR=/run/user/1006

XDG_ (URREHT DESKTOP=Unity

GTK_IM_MODULE=ibus
OE_QMAKE_LIBDIR_QT=/opt/fsl-imx-x11/4.1.15-2.1.8/sysroots/cortexa7hf-neon-poky-linux-gnueabi/usr/lib
0BIDUMP=arn-poky - Linux-gnueabi-objdump

1.1 4 EHFERENIMNEEE
{8 H arm-poky-linux-gnueabi-gee -v 82 A LAIEE gee A, KA E LA

arm-poky-linux-gnueabi-gcc --version
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alientek@ubuntu:~$ arm-poky-linux-gnueabi-gcc --version
arm-poky-1linux-gnueabi-gcc (GCC) 5.3.0

Copyright (C) 2015 Free Software Foundation, Inc.

This is free software; see the source for copying conditions. There is NO

warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

alientek@ubuntu:~$

1.1 5 &F gec lRAER

FEE R Qt Creator XX FHH
PATEAR I % Qt BRI FFAETT Kb LigATie ok, WA HREREEA XL, {EH ARM
-6 B X PR g B AR 7 4 REAE LMX6U HF AR Higfriesk, AR R e T
X G PEAs N fsl-imx-x11-glibc-x86 _64-meta-toolchain-qt5-cortexa7hf-neon-toolchain-4.1.15-2.1.0.
sho R4 Q AR CATHH N Q15.12.9, HBATATTHE F4 Qt5.12.9 1) Qt A4 .

2.1 F# Qt Creator

FATVEELE Ubuntu “F &K Qt, A4 LIEF MK IDE 355, H4 Qt Creator B2 Qt
] IDE(FERAER), AT A Qt Creator PRiEZAE 1. #F AW HE http://download.qt.io/arch
ive/qt/5.12/5.12.9/ F %k Qt 5.12.9. Qt B 5 .44 Qt Creator £ 3% 7E 1 [HI1X 4™ qt-opensource-linux
-x64-5.12.9.run. FA T B FHIXA gt-opensource-linux-x64-5.12.9.run B #7E Ubuntu 2225 E1HA],

@ éx download.qtio/archive/qt/5.12/5.12.9/ &

Qt Downloads

Name Last modified Size  Metadata
t Parent Directory

W submodules/ 16-Jun-2020 07:04

w single/ 16-Jun-2020 07:04

B gt-opensource-windows-x86-5.12.9.exe 16-Jun-2020 18:07 3.7G Details

B gt-opensource-mac-x64-5.12.9.dmg 16-Jun-2020 14:49 2.7G Details

B gr-opensource-linux-x64-5.12.9.rur 16-Jun-2020 14:48 1.3G Details

E mdSsums.txt T 16-Jun-2020 18:14 207 Details

BRI TS Sl S T A B (R R T &Y
For Qt Downloads, please visit gt.io/download

Qi® and the Qt loge is a registered trade mark of The Qt Company Lid and is used pursuant te @ license from The Qt Company Ltd

f their resp

All other trademarks are prope

The Qt Company

B 51 1 RETH QL5.12.9
i EMHARA T E, e & B T athl, BEHE7E Ubuntu £ fli ] weet $84 Tk,
o
Wget http: //download qt 1o/arch1ve/qt/5 12/5.12.9/qt-opensource-linux-x64-5.12.9.run

] 79.27M 26.0MB/s _eta 49s

5.1 2 £/ wget 3§47 Ubuntu ZIREIETE
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2.2 &% Qt Creator

T #5583 gt-opensource-linux-x64-5.12.9.run iX >34
T2 AT AT AR, AT 23

chmod u+x qt-opensource-linux-x64-5.12.9.run

sudo ./qt-opensource-linux-x64-5.12.9.run // ZVN sudo, HM LA YHTHET .
sk, MR Qt 5.12.9 XYl 2 4% AL

Welcome to the Qt 5.12.9 installer

This installer provides you with the open source version of Qt 5.12.9.
Please log in with your Qt Account credentials.
If you do not have a Qt Account yet, you can create one free of charge in the next step.

The Qt Account will give you access to Qt downloads, exclusive services, bug reports,
code review, and forums & wiki.

Network requests completed.

©

RE Next X

51 3 MBLERE
XEFEES QtIKS, &% Qt B https:/www.qt.ioiFM— K S . HEE 5 S Nexto

Qt 5.12.9 RERRF

Qt Account - Your unified login to everything Qt

Please log in to Qt Account )
Loging| 74 3@qg.com I

Forgot password? ,

Need s Qtaccountffl e @R Y IS HIRAIGS), HADERENES), 7

sign-up [valid email address

Password
Confirm Password

service terms

()

2= <) \ A

51 4 EE QtikS
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[ EAEH K. fein D IRERAE.

Qt5.12.8 REEF

QtOpen Source Usage Obligations
QtOpen Source version is available under GPL 2, GPLv3 or LGPL Y3,

Qt Please read and accept the Open Source L igations below. Reading the link below helps you choosing the right license for your project
hoosing the right license for vour projects
Bwor
GPLv2, GPL v3 and LGPL v3 obligations.
wou must not It pe license of Qt in ane project er product

= Provide a re-linking mechanism for Qt libraries
*Provide a license copy & explicitly acknowledge Qt use
»Make Gt source code copy available for customers.

whake “open’ consumer devices
® Accept Digital Rights Management terms, pleasa sea the GPLFAQ

| T r—— )

[ V' 1 am anindividual persan not using Qt for any comgany I 9 (o)}

— o] =
Bl 515 BEFERAER

W2 Re G, EEAE T .

Qr5.12.9 REEF

BEREF-Qt5.12.9

- Welcome to open source Qt 5.12.9 setup.

(D)

[<zs@ || Fow>- || mx

E 5.1 6 WHNLZERME

RS EHZ, BWBOARIT] ., &% fE/opt HX N, B F—2»5,

REIAR

IBREERE QL5.12.9 FIER, @)

Jopt/Qt5.12.9] ]l AR |

0
= = e

E 51 7 BRIARKTE/opt BRT
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B RYE, BT ZRIRIIRAE R L., Sl —P.

AR
HERER R

[ il |{ 2IE(S) i WHLIE(D) |

@
> @ Qt5.129
W] Desktop gce 64-bit
Android x86
Android ARM64-v8a
Android ARMyT
Sources
Qt Charts
Qt Data Visualization @)
Qt Purchasing
QtVirtual Keybeard
QtWebEngine
Qt Network Authorization
QtWebGL streaming Plugin
Qt Script {Deprecated)
= [V Developer and Designer Tools
Qt Creator 4.12.2

CSSE SIS SCSENITNCS

LEERFFAL & AT R B8 4.23 GB B%IEL

[<t—s@ | F—sm- ]| ==
L —

5.1 8 AHERZEIRIN
EIb= a1 73 R ol Ny 78
00 gsroommee ]
FFATEDIY

WEEU T SRR N ROR A TR,

Qt Installer LGPL License Agreement
GPLY3 with Qt Company GPL Exception License Agreement

GENERAL

Qtis available under a commercial license with various pricing models and packages that mest a varisty of needs. Commercial Qt license keeps your code proprietary where
only you can control and monetize on your end product’ s development, user experience and distribution. You also get great perks like additional functionality, productivity
enhancing tools, world-class support and a close strategic relationship with The Qt Company to make sure your product and development goals are met.

Qthas been created under the belief of apen development and providing freedom and choice to developers. To support that, The Qt Company also licenses Qt under apen
source licenses, where most of the functionality is available under LGPLY3. It should be noted that the tools as well as some add-on components are available only under
GPLY3. In order to preserve the true meaning of open development and uphald the spirit of free software, it is imperative that the rules and regulations of open source licenses
are followed. If you use Qt under open-source licenses, you need to make sure that you comply with all the licenses of the components you use.

(Ot also contains some 3rd party components that are available under different open-source licenses. Please refer to the documentation for more details on 3rd party licenses

| have read and agree to the terms contained in the license agreements. ] @

' do not accept the terms and conditions of the above license agreements

[<t—s@ [ Tom> | =

5.1 9 EEIFAIHYL

e 20, midi i

RERFNDESHTEMNTEEFRREQt5.129, Installation will use 4.23 GB of disk space.

[<z—s@ || =z0 || w»

5.1 10 Frahest

10
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LB, R TE K

EEXR Q5. 129H8

Qt

BF 2a(F) iRE Qt5.129 AF.

®

51 11 LREZRK

2.3 B2E Qt Creator Kits

Kit PEAEEMF, MR RMmEMEEMN, JRATTHEEARFE BN, UARKES
HIFHAFTF GRS, WIIUET Qt #5-1 & e !

KRBT EAANA RGN E ARG ENIRS, HASTIF A . G 22 g #
AL H RN AT LA a0 R HE 2T 9P

sudo vi /opt/Qt5.12.9/Tools/QtCreator/bin/qtcreator.sh

fE gtereator.sh R —4THA W N4, W NEFR.

source /opt/fsl-imx-x11/4.1.15-2.1.0/environment-setup-cortexa7hf-neon-poky-linux-gnueabi

1 source fopt/fsl-imx-x11/4.1.15-2.1.8/environment-setup-cortexa7hf-neon-poky-1linux-gnueabi
#! fbin/sh

_LIBRARY_PATH
ith the

B makeAbsolute() {
£ case S1 in

2.3 1 JGH1817 Qt Creator
TRAEIASC A . W FHE24TFF Qt Creator. “&” WIMEF 2 )G Gig1T. (EFEMEHXFH
FRITH Qt Creator)
/opt/Qt5.12.9/Tools/QtCreator/bin/qtcreator.sh &

alientek@ubuntu:~$ /opt/Qt5.12.9/Tools/QtCreator/bin/qtcreator.sh &

[1] 18672
alientek@ubuntu:~S

2.3 2 lF&1&1T Qt Creator

WA A/ A B DA R “Qt Creator” Bl /G R T GXEIAHE
FE R EFRRITIF Qt Creator, HNGwFSES 5| AEHARIFHRE T b L I IERED

11
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[ I S EF-UBuntu1604
(c)
Qe ]

THIELSR »

A NAERF

)

Qt Creator

2.3 3 N ZEFZITH Qt Creator

$THF Tools(T.E), T Options(I£L).

Qt Creator
X#(p) BIEE 2@ ERE) Analyze

IA@® I W) EEIH)

P Locate... Crl+k

c+4+(C) »
Tests ’ R
vupng
N '/ File Edit Help
Git 4
iz =
Y
All the standard features of| =

Marketplace

New to Qt?

Parse Build Output...

$H31E)

—~r

ock Window E...

» B android clo

Leam how to develop your Diff <
own applications and . pv——rrT
explore Qt Creator. FEF(Q)...

Get Started Now

L otAccount
MR online Community

3\ Bloas

@ UserGuide

7
14 15 16
0 21 22 23
7 28 29 30

Application Example

Bars Example

Tags: bars dat

Bluetooth Low Energy ...

HTTP

Calendar Widget Example

Chart Themes Example

Editable Tree Model Ex...

-

- Fortune’Semnver

— = r
:{eul:lg ﬂtr#(ill\:re to take a quick UI tour? This tour highlights important user interface elements and shows how they are used. To take the tour later, select Take Ul Tour | | Do Not Show Again | X

£, Type to locate (Ctrl.. 1 [ 2 searchResults 3 NEEFHEE 4 4ERWHE 5 QMLDebugger Console 6 HEfES

2.3 4 §TF “&m”
B & Qt Versions, mdishn, e#EIRAT L1 /N 222 ()58 X Pk 42 T (1) qmake, #5420
Jopt/fsl-imx-x11/4.1.15-2.1.0/sysroots/x86_64-pokysdk-linux/usr/bin/qmake, FF 4% Makefile, LA
PPFERET . RIS L FR N ATK-LMX6U Qt %{Qt:Version} .

8 TestResults = =

12
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Filker @) | Fieer @) | Kits (2)]

Kits Kits | QtVersions | (2iF53

Debuggers =~ CMake

itiz: http://www.openedv.com/forum.php r

5)

0 75 Name

~ qmake Location @

B x*EESs
M. Fakevim
@ 8y

{} c++

Qt Quick
HERETT
Qbs
it
Python
s BEAATIKCLMX6W at %{@t:Version})

y
kil ,‘ )]

NEB Y A

&
<

| Link with Qt...|

=E [FE=E [[ATK—l.stu It %{Qtversion}

£in
w

BB RERL

Language Client

T mdm

qmake B3 fopt/fsl-imx-x11/4.1.15-2.1.0/sysroots/x86_64-pokysdk-linux/usr/bin/gmake

No compiler can produce code for this Qt version. Please define one or more compilers for:

=

Testing *arm-linux-generic-elf-32bit

SEHIQL Ar5.12.9

Register documentation: \H’\ghest Version Only ~ \

Vet -

@ I[:ﬁAppLy MX cancel | « OK

2.3 5 BCE Qt Versions

R, 1%FE CH.

Filter | Kits 9
Kits = QtVersions %‘Debuggers CMake
—_ -
L] i Name Type (10) | "[
B wkERs T AU ferected i '
¥ Fakevim GCc (et 5261 n oo e ©
© = € GCC (C, x86 64bit in fusi/bin) clang E++
0} Cos } Manuacllang (C, x86 64bit in fopt/Qt5.12.9/Tools/QtCreator/libexec/qtcreator/clang/bin) Clang Custom " _@
-4 QtQuick [ ace LN
2 R ¢ uto-detection Settings...
3 Qbs
o FitEs
/it
& Python
E srm
el
0D g&
==k
&® Language Client
J& Testing

|/ Apply || % cancel || /oK |

23 6 IJ\\}JD C++

13
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Be B gm iy, ke A RN L1 /N 238 X mikeds . 42 /opt/fsl-imx-x11/4.1.15-2.
1.0/sysroots/x86_64-pokysdk-linux/usr/bin/arm-poky-linux-gnueabi/arm-poky-linux-gnueabi-g++. ¥
“HFR” BN ATK-1LMX6U-GCC.

[Filter | Kits @
Kits = QtVersions Debuggers =~ CMake
0 i Name Type
~ Auto-detected
8 whmER v G+
. GCC (x86 64bit in fusr/bin) [«
X. Fakevim GCC (x86 32bit in /usr/bin) Gcc ‘ s |
-c %
L GCC (C, x86 64bit in fusr/bin) ccc [ Removeal |
0 cos Clang (C, x86 64bit in fopt/Qt5.12.9/Tools/QtCreator/libexec/qtcreator/clang/bin) Clang - —
4 - Manual | Re-detect |
t Quick =
2 HEATETT
3 Qbs
o Eitas
/7 gith
@ Python
E sHirss
B
Rl . o fa e bocdb e rerfhin e bu i et tm b Far b B ot oot e e |
- RIESE(C): 86_64-pokysdk-linux/usr/bin/arm-poky-linux-gnueabi/arm-poky-linux-gnueabi-g++| @
RE&
Platform codegen flags: | T
B s
Platform linker flags: | |
&® Language Client ‘17‘
ABL: arm-linux-ger ~ =L
J& Testing @
loptifs|-imx-xd/4:1.15-2.1L.0/sysroots/x86, 64-pokysdk:linux/usr/bin/aim:peky:linux-gnueabilarim:peky-linux:gnueabi-g+)
@ « Apply || % cancel ‘ « OK

2.3 7 ELEHmIFRR
fic & Kits, K “HFR” BN ATK-LMX6U. 7E Qt mkspec 45 I “linux-oe-g++”7. HAh$% T
BlERE. AR T HA I, 50T B Ym B R

[filter | Kits
I Kits IQt Versions  {Ei¥28 Debuggers CMake
g5 ZH D) Add 3
B x&&Es - aael L Clone
¥ Fokevim ) ¥;ﬁl§5kcop Ot 5.12.9 GCC 64bit (B114) @) ‘ e |
O oo | settingsFilter.. |
-4 QtQuick @ B ATIKAMXEY) | Default Settings Filter...
2 HEHET & llATK—Lstu EX
£ Qbs File system name: 1
o PiEs Device type: | =m -
7/ it Device: | tEAhiEST (S £ TEIAEE) ~ || Manage... |
@ Python sysroot: | || sz |
E sire @) [c | <Nocompiler -
B s S @) [cr+: ATkLMxsU-GCC pusiaoecs)
0 e Environment: No changes to apply. \ Change... |
[E s Debugger: | system GDB at fusr/bin/gdb ~ || Manage... |
& Language client Qt version: @ ATK-.MX6U Qt 5.12.9 ~ | manage... |
JA Testing ot mkspec %
Additional Qbs Profile Settings@ ﬁﬁhlihuw—g@,—gtm m—fj’y S }t‘:% | change... |
CMake Tool: System CMake at fusr/bin/cmake - | \ Manage... |
CMake generator: CodeBlocks - Unix Makefiles, Platform: <none>, Toolset: <none> ‘W| &
@) [V ooty | % can@)f vox |

2.3 8 B E Kits
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2.4 BAERRE IR X5 & Kits
B TR

(7) Creato
% BIEE) MiEE) @f@) Analyze TR W AEBH)

[4 A= XA E (N)... Ctrl+N (2) <no document> s B
& TSR (). ctrl+o 1
A, AW
LRI AHE) '
FEERNTER) '
Sessions , Open a document
+ File > Open File or Project (Ctrl+0)
+ File > Recent Files
+Tools > Locate (Ctrl+K) and
- type to open file from any open project
Ll - type c<space><pattern> to jump to a class definition
- type m<space><pattern> to jump to a function definition
- ’ - type f<space><filename> to open file from file system
REFEXEL) Ctrl+shife+s - select one of the other filters For jumping to a location
» Drag and drop files here
= a3 YR ~ Filter ~ =
B (X) crl+Q
T

LI ~. Type to locate (Ctrl... 1 /A 2 SearchResults 3 FVARFHItE 4 &KiFW 5 QMLDebugger Console 6 BEE(SS 8 TestResults +

24 13FEmMB

1%EH Application 57 H Al Qt Widgets Application FAR

New File or Project

HiE— MBI FARIR -
7 © b

S _“ Qt Widgets Application Creates a Qt application for the
Application (Qt) desktop. Includes a Qt Designer-
Application (Qt Quick) . | [ based main window.

- -_ Qt Console Application
Application (Qt for Python) Preselects a desktop Qt for building
Library the application if available.
Hithm g

. HRNTE: =@
Non-Qt Project

Import Project

R

C++
Modeling
Qt

GLSL
General
Java
Python

(5)

% concel [[7 choose.|

2.4 2 EF B S5RR
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WH 400 test, 8 TREMIAL B, 1X BALE AZFEMILERE, B UUIIER B X T (home/H 1 44).

Qt Widgets Application — Qt Creator

] Project Location
> Location

This wizard generates a Qt Widgets Application project. The application derives by default from
QApplication and includes an empty widget.

6)
S ’testl ]I‘
£1228242: /home/alientek sl
BAEIANINEREE

2.4 3INEAEA test

BRIMEF qmake, sSidi B4

Qt Widgets Application — Qt Creator

Define Build System

Location
2 Build system Build system: | gmake -

(6)

<t—$@ﬂT—$mp| AR

& 2.4 4 BNBERSZ
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PRI, ERIA QMainWindow 2RI T .

Qt Widgets Application — Qt Creator

Class Information

Location
Build System Specify basic information about the classes for which you want to generate skeleton
¥ Details source code files.

Class name: ’Mainwindow

Base class: | QMainWindow -

Header File: ' mainwindow.h
Source file: \mainwindow.cpp
v| Generate form

Form file:  |mainwindow.ui

(5)
< b—%() | o]

& 2.4 5 %FLER

RETRIEFSCAHRIEE, BOAE, At

Qt Widgets Application — Qt Creator

Translation File

Location
Build System IF you plan to provide translations For your project's user interface via the Qt Linguist tool, please
Details select a language here. A corresponding translation (.ts) file will be generated for you.

2 Translation Language: <none> .

Translation file: <none=

1)
< b—%@) || K

2.4 6 BRI SCHERE
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EREM, KRB —RIE, wiFRTIRIER IMX6U ARM F&EM, T,

: Qt Widgets Application

Kit Selection

Location
Build System The Following kits can be used For project test:

Details | Type to filter kits by name...
Translation V' Select all kits
P Kits @)
v @ ATK-LMxsU  BHFEEREI6 Y ARMAE G dmie s s
v/ @ Desktop Qt 5.12.9 Gee 6abit  WbutnusE SiRiEX861 64 Cidmie A S -

()
e Bk

& 2.4 7 % Kits

RN, A7 Finish, 5.

Qt Widgets Application — Qt Creator

] Project Management
Location
Build System YERFIMB RINEIEE
Details FINZIRAZSIRG(): | <None> ~ | | Configure...
Translation
Kits
2 Summary
BRI
/home/alientek/test:
main.cpp
mainwindow.cpp
mainwindow.h
mainwindow.ui
test.pro
®)
<E—5) UK

2.4 8 B i A4z
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Bk ATK-LMX6U Kit 4ai¥, FHPrlPAE S Qt Creator R HH S 24 /E AR
X, EATUARHE S

mainwindow.cpp @ test - Qt Creator

{EIE(E) (@) @E@D) Analyze TA@D EHw) #HEH)
b= T B = mainwindow.cpp + X A <NoSymbols>

+ Unix (LF) +/Line: 1, Col: 1 B+

~ lici test 1 #include "mainwindow.h"
Lei test.pro 2 #include "ui_mainwindow.h"

~ liil Headers. o 3 O expected unqualified—id
|| mainwindow.h O 4 Mainwindow: :MainWindow(QWidget *parent) Quse of undeclared identifier 'Mainwindow' O unknown type name 'Qwidget'l
~ lie! Sources 5 ¢ QMainWindow(parent)

6~ , ui(new Ui::MainWindow)
7 {

|- main.cpp
mainwindow.cpp
» |z Forms

ui->setupUi(this);
1

© 11~ Mainwindow: :~Mainwindow() Ouse of undeclared identifier 'Mainwindow’ |

12 {
13 delete ui;
14 1

SRRy, SRR B]ﬂ@ﬁij

.9/ GEE) iﬁ ks, IR ‘E‘A‘%ﬂi«a

TiE: test

&8 Deploy Configuration

IE{T: test

HIMIERE(Kit) ®

ATK-L.MX6U Debug

Desktop Qt 5.12.9 GCC 64bit Profile
Release

highlights important user interface elements and shows how they are used. To take the tour later, select Take Ul Tour || Do Not Show Again | X

(2l L. Type to locate (ctrl... 1 [Efi@ 2 searchResults 3 WARFEHM 4 HiZHH 5 QMLDebuggerConsole 6 HE{ZSE 8 TestResults & P |

2.4 9 ]k ATK-1LMX6U
FEFR YA A A T R T Qt creator 2 | —™ ClangCodeModel ff:, iX
AMdfEEE, HEE Qt creator IASHRXMREMEE 1. sy “WBY” > “KTHM”, f£C
+HF=HE| “ClangCodeModel”, HUHAIERIT] . midikH, SR TENARE, i Now
RIA] 5 5 A0

EREET

Filter Show all
Name ~ Load Version Vendor =
~ Build systems (5]
- AutotoolsProjectManager 4.12.2 (4.12.0) Openismus GmbH
v CMakeProjectManager v 4.12.2 (4.12.0) The Qt Company Ltd
- CompilationDatabaseProjectManager (experimental) 4.12.2 (4.12.0) The Qt Company Ltd
v GenericProjectManager v 4.12.2 (4.12.0) The Qt Company Ltd
v QbsProjectManager v 4.12.2 (4.12.0) The Qt Company Ltd
v QmakeProjectManager v 4.12.2 (4.12.0) The Qt Company Ltd
v C++ (]
- Beautifier (experimental) 4.12.2 (4.12.0) Lorenz Haas
L~ clangCodeModel 4,12.2 (4.12.0) The Ot Company Ltd|
- ClangFormat 4.12.2 (4.12.0) The Qt Company Ltd
- ClangRefactoring (experimental) 4.12.2 (4.12.0) The Qt Company Ltd
v ClassView v 4.12.2 (4.12.0) The Qt Company Ltd
v CppEditor v 4.12.2 (4.12.0) The Qt Company Ltd
~ Code Analyzer (]
+ ClangTools v 4.12.2 (4.12.0) The Qt Company Ltd

— rnnrherk (a¥nerimentall 412 2(412 M Sarasu Marazou

K24 10 BUHE2) %k

Frihgmit, SdeE, AEEFHIZT! F Ubuntu T4 FRIZITA T FH ARM 40 %2843k k1
FEFI!
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HHE) BEE) 19:2E) BH@) Analyze TA(®T) Zfiw) #HEIH)

mE 2T B a (1) mainwindow.cpp & X A <NosSymbols> % Unix (LF) %/ Line: 1, col: 1 Bt
Wmesl — o @' m2inwindow. h" 3
| test.p 4 ©hainwindow.h"
~ [iHl Head: hizqmake © expected unqualified-id
Wl mal Mainwindow(Qwidget *parent) Ouse of undeclared identifier 'MainWindow' O unknown type name 'Qwidget‘l
~ lic! sourc AE indow(parent)
e ma| P BT Ui : :MainWindow)
=l ma s )
» [z Form: = pui(this);
Bh%
Add New...
i ~MainWindow() Ouse of undeclared identifier 'Mainwindow' [l
FhREHE..

i

Add Existing Directory...

AHOEE...

Find in This Directory...

Close All Files in Project "test"
RHAME "test”

a2
Open Docume]
R Expand All .15-2.1.8/sysroots/cortexaThf-neon-poky-linux-gnueabi/usr/include/QtWidgets -I/opt/fsl-imx-x11/4.1.15-2.1.8/sysroots/ 4
L orTexarnt bi/usr/include/QtGui -I/opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/cortexaThf-neon-poky-linux-gnueabi/usr/include/QtCore
I. -I. —T/opt/fsl—imx- APty 0/sysroots/cortexaThf-neon-poky-1inux-gnueabi /usr/1ib/mkspecs/linux-oe-g++ -o mainwindow.o ../test/
mainwindow. cpp
arm-poky-Llinux-gnueabi-g++ -march=armv7ve -mfpu=neon -mfloat-abi=hard -mcpu=cortex-a7 --sysroot=/opt/fsl-imx-x11/4.1.15-2.1.8/sysroots/
cortexathf-neon-poky-Linux-gnueabi -Wl,-01 -Wl,—-hash-style-gnu -Wl,--as-needed --sysroot=/opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/cortexathf-neon-
poky-Linux- gnueatﬂ o test main;o maimeindow.o mocmoimeindow.o fopt/ feloimeadl/a. 1152 1, B/Sysroots/(ﬂrtexaThF neon-poky—Linui- gnueakﬂ/usr/
'hb/h [ESv2-s0 -lpthread @)
B fusr/bin/make " EXEH.
apsed time: 00:03. @
L1l 1 [FE@ 2 SearchResults 3 WAEFHH 4 BiFHL 5 QMLDebugger Console 6 HEER 8 TestResults = m

2.4 11 %®iF ARM AR RIEF I
1E test TAEAE L H 3% T 43 build-test-ATK I MX6U-Debug A3, 25 9 1% HI SR o] $047
TR teste FATHE MBI KRG HFKT, FE8 N &0 BT ftest BLATLL T .
cd build-test-ATK I MX6U-Debug/
Is

alientek@ubuntu:~S cd build-test-ATK_I_MX6U-Debug/
alientek@ubuntu: S 1s

main.o mainwindow.o Makefile moc_mainwindow.cpp moc_mainwindow.o moc_predefs.h test ui_mainwindow.h
alientek@ubuntu: G

2.4 12 YmiEHkE) ARM EETHITIER

2.5 R Qt P

2.5.1 rsync 73k Qt BRI

£ Qt Creator FEUIMEHL T, 2 sfip 8 rsync KIEFEFRIR K. HT IERAE T LMX6
U T Qt XHARSG RS V1.9 L2 BA rsync #84, KUk AT DAR J5 8 M FH k7
R T QAR . HATRMEHIN T Ui X RGRAS, fEH REPATLL FES.

cat /etc/version
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root@ATK - IMX

Author: IF &5 [ F@qql252699831

ion v1.8 - Version vl.5

Version: v1.6
Jate:2020.11.18

version: v1.7
Jate:2021.61.87

version: v1.8

version: v1.9

2.5.1 1 BEFYRIXXHRGRAE
o BT rsync 154, WA LLEF S SR rsyne, 417 F EFRl2 SCHFF rsync.
rsync

root@ATK-IMX6U:~# rsync
rsync version 3.1.2 protocol version 31
Copyright (C) 1 2015 by Andrew Tridgell, Wayne Davison, and others.
Web site: http://rsync.samba.org/
5
64-b1t files
socketpail hardlinks, symlinks, IPv6, batchfiles, inplace,
append, ACLs, xattrs, iconv, symtimes, prealloc

rsync comes with ABSOLUTELY NO WARRANTY. This is free software, and you
are welcome to redistribute it under certain conditions. See the GNU
General Public Licence for details.

rsync 1s a file transfer program capable of efficient remote update
via a fast differencing algorithm.

Usage: rsync [OPTION]... SRC]... DEST
<y ; USER@EIHOST:DES

. : PTEENER. &#ESE
2.5.1 2 rsync f§%

WS RIS V19 1), AL royne Hi, KR FRBAFAOIT b,

SURHOAFRAT o WORAREHCAT ARG, TP 2.5.2 /MR rsyne 74 QUIEREIAA. 3X

SR R, ST S R R R
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¥TH Qt creator LAY T H > &I,

Qt Creator

e @RE o) Eke) any@RSTRY sew mae)
C++(CQ) »
(  QML/s * hin Examples...
Tests 4
Parse Build Output...
SMER(E) ’
Diff 4
Q| #7). |

New to Qt?

2.5.1 3 FTFF Qt creator R T E kIR

W FrRE I Generic Linux Device i% %
e ]

Filter &

2 Kits “ | Devices | Android QNX = SSH o

0 i BE(D) | Local e (27 £HEILEE) -

B x=xipiEs =
¥ FakeVim

A(N):  |Local PC | EEIEBEMASEE
i3
9 s, & SRR ERE:

Shi Ri ing P
o R B ceneric Linupevie ————[5) sume TS

-4 QtQuick Wik Unknown QNX Device
2 HEiisiT
8 Qbs

/" gitE
& python

F sirs
KakiEs . % cancel (5
o —
B A

& Language Client

b

ERUSE

X Tectina

« Apply | % Cancel

2.5.1 4 /0 Generic Linux Device & %&
RUGEERCE ZFR RN IP bR 44 . X B3R B 4 RN IMX6U-rsyne, R M %

R £ B3 FL i B AT ifconfig T8 415 BT R AR TP kbl 192.168.1.219, Hi) ™ RS H /' 44 4 root.
FFRAR TP HbETEARHE B DL PR RS .
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g B REEE R Linuxdg &
Connection
2 Connection olﬁiﬂﬂﬂﬁﬁ*]&%ﬂ?: IMX6U-rsync
O [rasEEmE Pk 192.168.1.219
e The username to log into the device: [root
O |rsw>| =
2.5.1 5 %/0 Generic Linux Device i¥&ZMEXER
R v 2.

IREMENEAELnuxigE
Key Deployment

Connection We recommend that you log into your device using public key authentication.

IF your device is already set up for this, you do not have to do anything here.

Otherwise, please deploy the public key for the private key with which to connect in the Future.
If you do not have a private key yet, you can also create one here.

2 Key Deployment

Private key file: . Create New Key Pair

Deploy Public Key

(11]
< t—5@) —

251 6 2FT—4%

Ml e R
summary
Connection SR,
Key Deployment S5, BEENEEIEERENE.
2 summary

(12)
< t—%@) X

251 7 BEHETER
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X ESMRER:, WRRBOER A T Ubuntu 2B S T FTP RS H KA K, iR Ub
untu A AR ) RSGEE ping i@

Device Test — Qt Creator

EERIEA.
Checking kernel version...
Linux 4.1.15-gbfed875 armv7l

EEETRAZSAA..
All specified ports are available.

Checking whether an SFTP connection can be set up...
SFTP service available.

Checking whether rsync works...
rsync is Functional.

Device test finished successFully.

@ #® Close

2.5.1 8 Mg FEE
BB AR Default 310 FRAE

I
Filter i1
& Kits “ | Devices | Android QNX  SSH
03 i 2% (D): | IMX6U-rsync (B Linux ZEIERIAIE) v FAN(A)...
B xiaas e 7 TG
K. rakevim ZFR(N):  [IMX6U-rsync
© %% ERLnx
{} c++ EEl: & Test
4 QtQuick WEPKZ: Unknown Show Running Processes...
2 BEET semiss HBEAM..
M Qbs bilkEich EEE Open Remote Shell
o e EranEich @ Specific key
/gt THEHH): 192.168.1.219 SSHEM(9): 22 |2 ¥ Check host key
@ Python SSHIMO: 10000-10100 EETETE: | 1080
E oz AF&EU): root
liazie elizH=a..
== CDB server executable: |Leave empty to lo...
& femits . = <)
@ * Cancel

2.5.1 9 & EBEWUFHEAA Default
B, AR SRS LEUE T A B L 1, # F R E Kits. MIKFTFLHE > &I,
WE Kits it & .
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Hrp, ZFREAME LK IMX6U-rsync, CHHEFF 2.3 /NI E R ATK-LMX6U-GCC, Qt ve
rsion JEHE 2.3 /N AL E 1 ATK-LMX6U Qt 5.12.9, Qt mkspec E5 linux-oe-g++. HAHE
AlicEZ% T K.

Filter Kits
| Kits @ Kits | QtVersions (g¥2 Debuggers | CMake
[y 3] ZH [12] Add
B w#ignes > ashiell Clone
¥ Fokevi 3 Desktop Qt 5.12.9 GCC 64bit =
v . emove
akevim - FahigE
@ =8 Arm-Qts.12.9 Make Default
{} Ci+ S S (Bl Settings Filter...
IMX6U-rsync —
4 QtQuick ez NEEY) GG Default Settings Filter...
2 RALET 2 @ [imxsu-rsync |(=
f Qbs File system name:
& FiEE Device type: @| Generic Linux Device -]
7 it Device: @|IMX6U-rsync (BFLinux EEEI2HAEE) ~ || Manage...
@ Python sysroot: ...
E s @|c: <No compiler> v
compiler: Manage...
B R E)[c++: [ATKA.MX6U-GCC -
0 s Environment: No changes to apply. Change...
B s Debugger: System GDB at fusr/bin/gdb ~ | Manage...
& Language Client Qt version: @ ATK-L.MX6U Qt 5.12.9 (F£) - | Manage...
& Testing Qt mkspec: (25] linux-oe-g++|
Additional Qbs Profile Settings: Change...
CMake Tool: System CMake at /usr/bin/cmake * | Manage... |

251 10 ®E Kits it &
P RBEIE Qt AR, 27 2.4 N HIINEGIE— test TUH ,  EFRATH WIWI 1) 2
i) IMX6U-rsync [ Kits ELF,

Qt Widgets Application

. Kit Selection
Location

Build System The following kits can be used for project test:

Details Type to filter kits by name...
Translation @ select all kits
> Kits
T Arm-Qt5.12.9 =
T Desktop Qt 5.12.9 GCC 64bit =
v| B IMX6U-rsync ¥ -
= 1] #fE -

<E—%@) |F—FN>|| BUA
2.5.1 11 B2 test I B Fix#*% Kits
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B AE FH IMX6U-rsync iR .

main.cpp <Select Symbol> + | Line:1,Col: 1 B+
~ lim test Warning: The code model could not parse an included file, which might lead to
| test.pro incorrect code completion and highlighting, for example.

+ [ifl Headers 1 #include "mainwindow.h"
~ |i=d Sources

main.cpp

e+ mainwindow.cpp
» iz Forms

Show Details | Minimize

#include <QApplication>
O O expected unqualif“\ed—idl
5 * dnt main(int arge, char #argv[])

O QApplication a(argc, argv); QOwvariable has incomplete type 'QApplication'
O MainWindow w; Qunknown type name 'MainWindow’
w.show();

return a.exec();

TH: test
HE: SWBEELnuxEN
iZ1T: test (on IMX6U-rsync)

WREFEK) R
IMX6U-rsync Debug
SR Profile

Release

[Bll ~. Type to locate (Ctrl... 1 [AE@ 2 Searc... 3 J\'T‘ﬁﬂﬁ'— 4 RIEMEH 5 oML ...

& 2. 5 1 12 EFFER AR
XTI H A, E%%ffétlﬂiﬁ?%ﬁ HIBITHET -

= B+ = pp ele bo o] =
model could not parse an included file, which might lead to

lo te] 1932 letion and highlighting, for example. sShow Details | | Minimize

. P HC pmomake Binwindow. h" 0
- licl se
Iﬂ EEE Bpplication>
E = O expected unqua'l.if'ied—idl
G =17 E argc, char *argv[])
* |k Fo &
E%ﬁm}_ ation alargc, argv); Ovariable has incomplete type 'QApplication'
&z dow w; Qunknown type name 'Mainwfndnw'l
Deb ;
3
Add New... a.exec();
a AR

Add Existing Directory...

| | Open Do FRONEE...
oD Find in This Directory...
Close All Files in Project "test"

EHTE "test”

B2
Expand All
1l ~. Type to locate (Ctrl... 1 [AEF@ 2 Searc... 3 HARE.. 4 HEREE 5 oML

5251 13 MBIETAE
5N FRE Py H A R DU B IRE e AT, PRI LCD Bife ERTLUE B A2 [, X2
Ijﬂidl]‘WTEl’J testE EIIﬁE 2, Q@RI IESS K.

main.cpp < | <Select Symbol> = Unix (LF)
~ liz test Warning: The code model could not parse an included File, which might lead to incorrect code completion
| test.pro and highlighting, for example.

v [@l Headers

~ ! Sources 2
=]
main.cpp 3 #include <QApplication>

* Line: 1, Col: 1

Show Details = Minimize

1 #include "mainwindow.h"

B r— O expected unqualified-id il
e~ mainwindow.cpp

* int main(int arge, char sargv[])
+ | Forms
(o] Qapplication a(arge, argv); QOvariable has incomplete type 'QADD'LiCatian‘I
o] MainWindow w; Ounknown type name 'MainWindow'
w.show();

return a.exec();

0. -
Pebus  5pen Documents R RRERFEH
’ in. = test (on IMX6U-rsync) %

iall ~. Filter

13:37:11: Starting /opt/test/bin/test ...
[ QStandardPaths: XDG_RUNTIME_DIR not set, defaulting to '/var/volatile/tmp/runtime-root'
K

[Bl £ Tvpe to locate (Ctrl...
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2.5.2 & rsync FR Qt ZREH R

BT IEAJR T IMX6U ] Qt KRG CUIF RS VIS ZRTH) HBA sftp B rsync, T
CABRATT Ee e s b — Rk TR, 2R ssh M sep ERE P ACE BB EAHAAT .
BH N RGRRAS T IEAT LR 2.5.1 T, BBCER B A48, R rsync 74T Q
t A, BT,
IO TR, $TIFRI.

test - Qt Creator

SIHE) EREE) WEE) BEO) AHGILQ) TA@ E=GiNEEEG)]

~ iz test c++(©)
|m test.pro

» il Headers QMLIS
» [z Sources Tests

v lidi Forms HEIEHED(Q

Git

Form Editor ' Open a document
Parse Build Output...
$hE8(E) » « File > Open File or Project (Ctrl+0)
Diff « File > Recent Files

v
-T:>:>l > Locate (Ctrl+K) and
@)l AR (O)... l e to open file from any open project
- type c<space><pattern> to jump to a class definition

n> to jump to a function definition

Spdt
- spa name> to open file from File system
E|E([ one af the ot her filters For jumping to a location

+ Drag and drop files here

I;‘ ' Open Documents s B =
Debug -

>

[ 2. Type to locate (Ctrl... 1 /A 2 SearchResults 3 MARFHE 4 HEHE 5 QMLDebugger Console 6 HESS 8 TestResults * = O

& 2.5.2 1 $TFFEIN
BB, AR AN “IMX6U”, 1E58 6 LSRR ip bk, WS ip bk A 2 [FH
SER, A LA PREARLG FMEE R SE 5.5 /NI BB ERA ip. BRIAUR I N 22,
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|Filcer | s (<))
& Kits Devices | Android QNX | SSH
m o B&(D): | MX6U (BELInux XXFEILEE) -\ FA).. |
B wHERs i L omse
9 HEL JEAALinuX
o s T —t |
4 Qt Quick WaTiRES: Unknown |show Running Processes....
2 ERET - \ HBLH.. |
i 5105 Rt P [_openremoteshel_|
& ob TR 25 9 Wil pen Remote Shel
Qbs ek, e RSl E 7 2 NP B
& EAs Eian &3 ‘e Default * Specific key
/T EHE: [192.168153  ssuin(s): 22 2| Checkhostkey
# Python SEO; [oo00-10100 | mEfE: 0% |2
E sz o AFAEW: |root |
s ©)
AATH: | | ol | oEEmEs.
s
- GDB server executable: |Leave empty to lo...|
[& s .
& Language Client
& Testing

() |\  Apply \IX Cancel || « ok

2.5.2 2 Ywig &

AT ER) “ B4, £ ATK-LMX6U Kits BIEF & RRARATNIA BER) “LMX6U” B

%o
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I
Filter Kits g)
QtVersions = #FiZ3 Debuggers | CMake
iy s ) a0 Add r
B wahiEiEs > Bbtedl Clone
¥ Fakevim ) = .2:5[({0,{: Qt 5.12.9 GCC 64bit (£1iA) @) —
0 s T | e oo
{} C++ " Settings Filter...
4 QtQuick Default Settings Filter...
2 HEAET 2 ATK-LMX6U =
f Qbs File system name:
o Fides Device type: Generic Linux Device ~
/gt Device: @) || Lmxou GEALInux £2HTIAEE) - | manage...
e Python Sysroot: [ ...
= e ) C: | <No compiler> -
K Compler Coi: | ATK-LMX6U-GCC | e
[ =S Environment: No changes to apply. Change...
B AL Debugger: imx6ull ~ || Manage...
& Language Client Qt version: ATK-LMX6U Qt 5.12.9 - || Manage...
& Testing Qtmkspec:
Additional Qbs Profile Settings: Change...
CMake Tool: System CMake at fusr/bin/cmake ~ || Manage...
CMake generator: CodeBlocks - Unix Makefiles, Platform: <none>, Toolset: <none> Change... =

252 3 wREEH
iR H BT ATK-LMX6U &4 Debug B0 .

test - Qt Creator

BIEE) 192E) BEF@D) Anayze THEQD FfHw) #HEEIH)

<no document>
~ li test

Lo test.pro
» lisl Headers
» lic! Sources
» lid Forms

Open a document

« File > Open File or Project (Ctrl+O)

« File > Recent Files

« Tools > Locate (Ctrl+K) and

type to open file from any open project

ype c<space><pattern> to jump to a class definition
ype m<space><pattern> to jump to a function definition
type f<space=<filename> to open file from file system

- select one of the other filters For jumping to a location

HE: SWBLERLinuxEN « Drag and drop files here
iB1T: test (on IMX6U)

WMER(Kit)
ATK-.MX6U

Desktop Qt 5.12.9 GCC 64bit Profile

Release

[l £ Type to locate (Ctrl. 1 searchResults 3 WARFHEY 4 EFHEEH S5 QMLDebugger Console 6 HERE

2.5.2 4 HRIRE ATK-LMX6U Eff

8 Test Results = O

M IH AL, 54 ATK-LMX6U %4, %4 Run. MiFRiEE SFTP FA& A, BORFRATHT X
PERGUKA sftp, AREEI sfip bA%.
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test - Qt Creator
XHE) EE(E) 1HEE) B analyze TA®M BfHw) M)

Manage Kits... b Eﬁﬂ.
Active Project SR
test T Fik FEITEUNXEN - Fm - EGA..
Import Existing Build... Files to deploy:
. oOverride deployment data from build system
Build & Run E .
o Local File Path Remote Directory
®) /home/alientek /build-test-ATK_|_MX6U-Debug/test fopt/test/bin
(1)
T Desktop Qt 5.12.9 GCC 64bit
7 Build RNMRARETE #iE -
P Run
Kill current application instance @)
Project Settings
[msm:ﬁzﬁ @ ~@)[X]tt -
{BiRE = -
e=lt 7 Deploy 5 - BN
FHRR
Environment BT
clang Code Model
Clang Tools IE{TECE: | test (on IMX6U) - Add... Fir ... Clone...
Testing
Executable on device: ‘opt/test/bin/test =
1 (@8 2 SearchResults 3 RAEEFHEE 4 BFHH 5 QMLDebugger Consale 6 HEE(ER 8 TestResults + =

2.5.2 5 Bk SFTP EAE3C#
7SN Depoloy 25, 164 “Custom Process Step”s

test - Qt Creator

M) B%E(E) 1WEE) BE@O) Analyze THE@D EfHw) EEIH)
Manage Kits... D Eﬁﬂl

Active Project i
test = Fik EEFTBLnuxEM - &= - BRE..
Import Existing Build... Files to deploy:

oOverride deployment data from build system

Build & Run . .
Local File Path Remote Directory
@ ATK-1.MX6U /home/alientek/build-test-ATK_I_MX6U-Debugj/test /opt/test/bin
/" Build
2 Desktop Qt 5.12.9 GCC 64bit
/* Build s Lopse i owdn] #E -

P Run
Kill current application instance
Project Settings I

! 9 ilDeploys 3 - @)
RS Custom Process Step 1 @
BRI Deploy files via rsync
k=R Install into temporary host directory E
Environment Kill current application instance L EH%E... || Clone...

Clang Code Model

Make
Clang Tools

Run custom remote command

Testing nftest
&lEtarball E. ] )
S aE P Use this command instead
EIESFTP LS S8 iek/huild-test—ATK_\_M)(ﬁU-Debug/test
@R SFTP_EfF R E tarball - L

1 [ 2 Search Results 3 [IAREFHE 4 HKiFHE S5 QMLDebuggerConsole 6 HEfSE 8 TestResults ¢ =

2.5.2 6 N “Custom Process Step”

P. Type to locate (Ctrl.
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I Command A4 ssh, Arguments: A-p %{Device:SshPort} % {Device:UserName}@% {Device:H
ostAddress} 'mkdir -p % {CurrentRun:Executable:Path}'. Working directory:Ekik 4% {buildDir} .
BERMBEXEMAS T, BLTHERTIK.

test - Qt Creator
XiEE) BEE HEE) BE0) andlyze TED EHEWwW #EHH)

Manage Kits... b Eﬁi&l

Active Project BE
test - Hik: SEFTEnuxENL || F - e
Import Existing Build... Files to deploy:

N Override deployment data from build system
Build & Run

2

Local File Path Remote Directory
- - ', .Jnome/aliantek/bujild-test-ATK 1 _MX6L-Debug/test foot/test/hin =~ ! = . -
& ATEL A6, o (Device:SshPort) %{Bevice:UserName) @ @@m@@ﬂﬂffgﬁaﬁ.g‘i@as}} ‘mkdir -p %{CunrentRun:Executable:Path)?

2 Desktop Qt 5.12.9 GCC 64bit

/" Build BN e WS -
P Run
Kill current application instance

Project Settings

CustomProcess Step: ssh -p 22 root@192.168.1.53 'mkdir —p/opt,‘test/b\n'@ iﬁdﬁé}gh S -
‘RIS c & m ] o
HEME ommand: E ...
FIETR Arguments: -p %{Device:SshPort} %{Device:UserName}@%{Device:HostAddress} 'mkdir -p %{CurrentRu 5 "]
Environment i i s e we

Working directory:|[%{buildDi ...
clang Code Model 9 y IT* {bulldpir} Jl I

ST

?lan.g Tools A iDeploys 3% @ ﬁ%%{@%@l@
esting

E5

E{TEE:  test (on IMX6U) - Add... FnE.. Clone...
P, Type to locate (Ctrl... 1A 2 SearchResults 3 WAREFHEH 4 &FHH 5 QMLDebugger Console 6 E{SEE 8 TestResults = =

252 7 KNS ETE

FUSIN—A Custom Process Step

test - Qt Creator
XHE) BI\BE) WEE) @iE@) Analyze TH(I) FH(w) ZFEEIH)

Manage Kits... D Eﬁﬂl

Active Project BE
test - Kk BBIEELnxEN < || Fmoo- Ero
Import Existing Build... Files to deploy:

override deployment data from build system

Build & Run - :
Local File Path Remote Directory
I ATK-LMX6U /home/alientek/build-test-ATK_|_MX6U-Debugy/test /opt/test/bin
/7 Build
= Desktop Qt 5.12.9 GCC 64bit Custom Process Step | &
/7 Build Deploy files via rsync S -
> Run Install into temporary host directory

Kill current application instance

Project Settings

Make 68.1.53 'mkdir -p fopt/test/bin' g -
fe i Run custom remote command E
UEBRE 32 tarball | HIE
IR ENFEREETE I;ev\(e:UserName)@%([)evice:HosrAddress} 'mkdir -p %{CurrentRun:E
Environment B SFTP L1E 34 ' |l s
Clang Code Model B SFTP_E1E RS Etarball | =
gl [Fhoein?s

&5
IE{TECE: | test (on IMX6U) - || Add. SaE... | Clone.

8 TestResults = =

" Al
2.5.2 8 BRM— “Custom Process Step”

2 SearchResults 3 [FARFHEIE 4 RiFHd 5 QML Debugger Console 6 HEEE
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NI Command A scp, Arguments: AJ-P %{Device:SshPort} % {CurrentRun:Executable:FileName}

% {Device:UserName} @% {Device:HostAddress} :% {CurrentRun:Executable:FilePath} . Working
directory:ER 1A % {buildDir} .

test - Qt Creator

XIHE) EEE HEE) (D) Analyze TA() =fHw) #HEhH)

/home/alientek/build-test-ATK_|_MX6U-Debug/test fopt/test/bin E
Manage [ —) . - - . T y——
=P’ /s{Device; o{CurrentRun; Name}, %{Device:UserName}@?/s{Devies ;@atagd,n@s,gzﬁl‘ﬁ.{@tmngmﬂm\|
Active Project
! S E L) s -
test S
Kill current application instance
Import Exisfing Build...
Custom Process Step: ssh -p 22 root@192.168.1.53 'mkdir -p /opt/test/bin' HE -
Build & Run Command: ssh Ba ..
= ATKA.MX6U Arguments: -p %{Device:SshPort} %{Device:UserName}@%{Device:HostAddress} 'mkdir -p %{CurrentRun:E
./ Build
Working directory: |%{buildDir} FE...
3 Desktop QL 5.12.9 GCC 64bit
2 Build Custom Process Step: scp -P 22 test root@192.168.1.53:/opt/test/bin/test @ iE'JE_S,AQ HiE -
¥ Run Command: [s(p ” ..
Project Settings Argum ~ 'U»P %{Device:SshPort} %{CurrentRun:Executable:FileName} %{Device:UserName}@%{Device /. ]I‘
REE working direcmry:ﬂ%{buildDir} ” FE...
ISR T
P Fiveploy % -| @) B\ %{buildDir
Environment
Clang Code Model ——
Clang Tools (i
Testing SETRE: | test (on IMX6U) | Add.. E65. | Clone..
Executable on device: Jopt/test/bin/test
Alternate executable on device: Use this command instead

1[7A# 2 SearchResults 3 WHAEFHEH 4 ®FHE 5 QMLDebugger Console 6 HE{ES 8 TestResults # =

252 9 ZiES 5T E

P, Type to locate (Ctrl..

R ARG, s AT e F5 S NRBRE. FEDy A 32 BT, W VR Bl C 2t
PERE R RS BT AR E4AT . T AR LAY LCD R ER T — AN E M.

test - Qt Creator

XfE) BEE f2E) AR Anayze TA®D) BEW EH)

B 2T ® B = <no document> s B+
* lim test

Le test.pro
v lirl Headers
* les Sources Open a document
» i Forms
@ « File > Open File or Project (Ctrl+O)

lename> to open file system
f the other filters for jumping to a location

« Drag and drop files here

x11/4.1.15-2.1.0/sysroots/cortexaThf-neon-poky-linux-gnueabi -o test main.o mainwindow.o moc_maimwindow.o jopt/fsl-imx- |~
x11/4.1.15-2.1.0/sysroots/cortexa7hf-neon-poky-linux-gnueabi/usr/1ib/1ibQtswidgets.so /opt/fsl-imx-x11/4.1.15-2.1.0/
sysroots/cortexa7hf-neon-poky-linux-gnueabi /usr/1ib/1ibQt56ui.so /opt/Fsl-imx-x11/4.1.15-2.1.0/sysroots/cortexaThf-neon-
poky-Llinux-gnueabi/usr/1ib/1ibQtSCore.so /opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/cor texaThf-neon-poky-Llinux-gnueabi/usr/
1ib/1ibGLESv2.50 _lpthread
11: + 3R fusr/bin/make" ERBH.
11: Connecting to device "I.MX6U" (192.168.1.53).
TEXHFRRHE 6200 KFPNHRKLME, EEAR.
BRSRRR,
Trying to kill "jopt/test/bin/test" on remote device... @)

mote application killed.
BRSRRR,
: IETERR "/usr/bin/ssh" -p 22 root192.168.1.53 'mkdir —p fopt/test/bin'

@ 11:45:06: B /usr/bin/sshm EMBH,
11:45:06: IETERR "/usr/bin/scp” -P 22 test root@192.168.1.53:/opt/test/bin/test

11:45:07: BB/ usr/bin/scpm EMIBH,
11:45:07: Elapsed time: 00:06.

o 1 B8 2 Search Results
252 10 2EiETT, AW ER LCD HEI—N=BMNED

3 ARFHYE 4 HiFEH .}MLDebuggErConsole 6 FIE{55 8 TestResults ¢ = 0O
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=% Ubuntu &1 Kits 5k Qt MR

3.1 Ubuntu %#¥ Qt MR

16 2.4 /N BLRALE test TAE B O4 Ik FflH ATK-LMX6U Kit. A4 R7—/Nii & Qt Cr
eator ZZREI H W5 1) Kit, 4471 Desktop Qt5.12.9 GCC 64bit. FATEAE Ubuntu EizfT, 4
PAVRIEREILI, G 1 H IFE 75T LAZE Ubuntu b3 470!

mainwindow.cpp @ test - Qt Creator

| 3@

BIE(E) 19ERE) BEQD) Analyze TE@ HfHw) #EBIH)

HE 2 @ |EE mainwindow.cpp * <Select Symbol> + | Unix (LF) # Line: 1, Col: 1 B+

~ li test 1 #include "mainwindow.h" 1

Lo test.pro 2 #include "ui_mainwindow.h"

~ lirl Headers
Inl mainwindow.h 4 MainWindow: :MainWindow(QWidget *parent)

~ i Seurces 5 : QMairWindow(parent)
(| Main.cpp - 5 ui(new ui::Mainwindow)
mainwindow.cpp T {

vl Forms ui->setupUi(this);

3
1 ¥ MainWindow: :~MainWindow()

delete ui;

TiH: test
E8E: Deploy Configuration

+ — A=

& il ~ Filter
IE{T: test Fimx—x11/4.1.15-2.1.0/sysroots/cor texa7hf-neon-poky-linux-gnueabi /usr /include/Qtwidgets ~1/opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/ -
AR (it) Ineon-poky-Linux-gnueabi /usr/include/QtGui ~I/opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/cortexaihf-neon-poky-Linux-gnueabi/usr/include/QtCore
opt/fsl—imx-x11/4.1.15-2.1.8/sysroots/cortexaThf-neon-poky-Linux-gnueabi fusr/1ib/mkspecs /linux-oe-g++ -o mainwindow.o ../test/

2 Debu pp
ATICEMAGY) 9 Ux-gnueabi-g++ -march=armvTve -mfpu=neon -mfloat-abi=hard -mcpu=cortex-a7 —-sysroot=/opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/
Desktop Qt 5.12.9 GEC 64bit  Profile hcon-poky-Linux-gnueabi -WL,~01 -WL,--hash-style=gnu -Wl,--as-needed --sysroot-/opt/fsl-imx-x11/4.1.15-2.1.0/sysroots/cortexaThf-neon-

gnueabi -0 test main.o mainwindow.o moc_mainwindow.o  /opt/fsl-imx-x11/4.1.15-2.1.8/sysroots/cortexaThf-neon-poky-1linux-gnueabi/usr/
Release idgets.so fopt/fsl-imx-x11/4. 2.1.8/sysreots/cortexa7hf-neon-poky-linux-gnueabi/usr/1ib/1ibQtsGui.so fopt/fsl-imx-x11/4.1.15-2.1.8/
IrtexaThf-neon-poky-linux-gnueabi /usr/1ib/1ibQtSCore.so fopt/fsl-ime-x11/4.1.15-2.1.0/sysroots/cortexaThf-neon-poky-Llinux-gnueabs fusr/
2.0 -1pthread
$8 /usr /bin/make ESIBH,
apsed time: 00:03.

[l ©. Type to locate (C 1@ 2 SearchResults 3 HAREFHH 4 HiZWH 5 QMLDebugger Console 6 IE{SE 8 TestResults *

& 3.1 1 EFETHRE Kit 4HiF
M7, AR RAT 2R AT ANE .

XIHE) {BE(E) #EE) Ei@) Anayze TA®T) EfHw) EHH)

mainwindow.cpp

X <Select Symbol> + Unix (LF) % Line: 1, Col: 1

- lim test 1 #include "mainwindow.h"

L= test.pro 2 #include "ui_mainwindow.h"
~ linl Headers
|n] mainwindow.h 4 Mainwindow: :MainWindow(QWidget *parent)
~ lied Sources 5 : QMainWindow(parent)
e« Main.cpp - » ui(new Ui::MainWindow)

mainwindow.cpp T {

¥

ui->setupUi(this);

Mainwindow

1 v Mainwindow: :~Mainwindow()

13 delete wi;

kel ~ Filter

Open Documents s B3
mainwindow.cpp

ERAERE, WY qnake HE.
E#EBR "fusr/bin/make" -j16

: Nothing to be done for 'first'.
i " fusr/bin/make" ENBH,
Tlapsed time: 00:80.

(I ©. Type to locate (Ctrl... 1 [@ME 2 SearchResults 3 UARFHE 4 &KiFWi 5 QMLDebugger Console 6 BEE(SS 8 TestResults + = 0O

& 3.1 2 Ubuntu LEIT4RIFH Qt NRATERF
ZPLIE AT IMX6U ) R4 Qt A X aid A, CARBHETR, AEMNKEKAHITE!

BF-A
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